
Chapter 19 (Number & Data Crunching)

E x c e l  S e c r e t s
Fill up, fill left
The Fill Right and Fill Down commands (Edit menu) have 
been classic time-savers. They let you copy the same 
number or formula into all the cells to the right, or below, 
the selected one.

If you press Shift while choosing these commands, they 
change to read Fill Up and Fill Left. They do what they say.

Edit just one graph bar
To edit a chart, you double-click it. You can edit just one bar
or slice of a chart, too, if you ⌘-double-click it. That way 
you can change its color or its border style without 
affecting the rest of the chart.

More page-numbering tricks
In the latest version of Excel, you have far less reason to 
type out the arcane codes needed for time-stamping, date-
stamping, or page-numbering your printout. As we 
discussed in the previous Secret, you can just click one of 
the little icons in the Header or Footer dialog box to insert 
the correct code into the text box.

Usually you precede a code with the ampersand (&) 
symbol. For example, &L, &C, and &R make the text that 
follows the code left-justified, centered, or right-aligned, 
respectively. Then there's &D, &T, and &F, which print the 
date, time, and file name.

But what if you really want to print an ampersand symbol? 
They think of everything: that code is &&.

How to set up startup documents 
When you install Excel, its Installer puts a folder called 
Excel Startup into your System folder. You can put almost 
any kind of Excel document into this folder: chart, macro 
sheet, add-in, and so on (anything except a Template). 



When you next run Excel, these items will open 
automatically.

Lotus stomping (version 3.0 only)
In a new spreadsheet, press ⌘-right arrow and then ⌘-
down arrow; you’ll jump to the very last cell in the immense
spreadsheet. Use the scroll bars to scroll down and 
rightward until only a single cell is 



showing. Using the Row Height and Column Width 
commands, set the last cell’s height and width to zero.

Finally, click the tiny square that remains. You get a brief 
display of anti-Lotus Corp. propaganda, and then you’ll see 
a list of the Excel design team. To end the display, just use 
the scroll bars.

Our only regret is that this trick doesn’t work in Excel 4.0 
or later.

3-D in System 6
In System 7, Excel’s toolbar icons use shading to give a 
three-dimensional look.

You can get this nice visual aid in System 6, too, by holding 
down the Shift, 3, and D keys while Excel is launching.

Create a folder on your hard drive and name it Network 
Install. (It can be named anything, of course, but this is at 
least an indicator of its purpose.) One after another, insert 
your system disks into the floppy drive of a Mac on the 
network and drag the floppy’s icon into this folder. Each 
floppy’s contents are copied into the Network Install folder,
one folder for each disk. 

Now open the Network Install folder. Open the first System 
7 installation disk folder (called either Install, Install 1, or 
Install Me First). Drag the items called Installer Script and 
Installer out of their folder into the enclosing Net Install 
folder.

You can double-click the Installer to run it. You finally are 
able to install the system software onto any Mac on the 
network — without having to feed the Mac any floppy disks 
at all! 

F i l e M a k e r  S e c r e t s

Design a layout for the Classic-sized screen 
(ClarisWorks, too)
Suppose that you have a nice big monitor, and you’re trying
to design a layout that will work equally well on compact 



Macs like the SE and Classic. It’s hard to guess exactly how
big to make the layout.

But Claris has done the work for you! Choose Help from the
Apple menu. The Help screen is exactly the correct size for 
the compact Macs. Use this window as a model for sizing 
your own layout.

Look up only one record 



You can set up a field in a FileMaker database that gets 
filled in automatically by consulting another FileMaker file. 
This is the famous lookup function. 

When you type a customer ID number into an order blank, 
for example, FileMaker consults your master customer 
name-and-address file and automatically fills the name and 
address into the order blank.

But this lookup function is one way, one time. If you change
the spelling of someone’s name in your customer list, the 
change doesn’t ripple through to the order blank.

Of course, the Edit menu contains a Relookup command. 
With that order-blank file open, you can choose Relookup; 
FileMaker consults the customer file, compares those ID 
numbers again, and pastes the updated address 
information into the order blank. 

Here’s the tip, though. Instead of waiting while FileMaker 
scans every single record in the file, looking for records to 
update, you can force it to look up only one record. To do 
so, just edit some tiny aspect of it. Type a letter, for 
example, and then immediately delete it. Press Enter and 
FileMaker will look up only the record you
Drag-and-drop
One of Excel’s neatest features (version 4 and later) is that 
you can drag a selected block of cells, either to copy them 
or simply to move them. (You may recognize this feature 
from its invaluable counterpart in Word.)

Two obstacles may stand in the way of your making this 
work. First, choose Workspace from the Options menu and 
make sure Cell Drag and Drop is selected.

Second, you have to know where to drag. You can’t just 
click in the center of some selected cells. Instead, carefully 
position the cursor at the edge of the outline of the selected
cells and drag that.

(To copy the cells instead of moving them, press Option as 
you drag.)



Q u i c k e n  S e c r e t s

One-key Category-window splitting
Quicken versions starting with 3.0 let you subdivide a 
particular transaction into any number of categories. For 
example, in one credit card payment, you may want to 
record payments for office supplies, work-related 
publications, and a medical expense.

Trouble is, to see your categories, you have to click the 
Split button at the bottom of the screen. The same goes 
with collapsing the category 



list, too — again, you have to click the Split button. That’s a
lot of mousing.

But not if you realize that there’s a keyboard shortcut for 
clicking the Split button. It’s ⌘-E.

So, they’re not always perfectly logical. But for the true 
power user who encounters the same old dialog boxes 
frequently, these one-key shortcuts, after you’ve learned 
them, can be a handy time-saver.

Chapter 20 (Graphics and 3-D)
The Auto-trace feature

FreeHand, Illustrator, and Canvas all offer auto-trace features.
You open a bitmapped image (PICT or TIFF, for example). The 
program automatically draws a PostScript path — a series of 
Bézier curves — along every edge where white meets black in 
the image. When you’re done, you delete the original 
bitmapped image, and you’re left with a smooth, high-
resolution, sharp-printing PostScript graphic.

The best autotraces come from images where there are clear 
changes from black to white. If your original is a grayscale 
scanned image, therefore, coax it toward being a black-and-
white image before tracing. Use the program’s contrast 
controls, for example, to blanch the whites and darken the 
grays. Or save the image as black-and-white, and then reopen 
it before tracing. 

I l l u s t r a t o r  S e c r e t s

Bypass the “Open template” dialog box
If you’re not somebody who uses Illustrator to trace 
scanned images much, then the “Please open a template or 
click None” dialog box (which appears every single time 
you start a new document) can get tiresome fast.

To bypass it, press the Option key while you choose New 
from the File menu (or while you press ⌘-N).



MacDraw Pro, ClarisDraw, and ClarisWorks

Why are we lumping these together? Because they come from 
the same company, look and work almost exactly alike, and are
modeled on each other.

The discontinued MacDraw Pro (reissued as ClarisDraw) is, of 
course, the more powerful of the two — drawing is all it does. 
But many of these 



shortcuts apply equally well to both of these polished, easy-to-
learn programs. We’ve indicated which tips apply to both. 
When we mention ClarisWorks, of course, we mean its 
drawing module.

begin sidebar: True Fact

What happened to SuperPaint?

We’ll be honest. There are three reasons we left SuperPaint out of this 
discussion.

Reason 1: We didn’t really. All of our general painting tips apply to 
SuperPaint’s paint layer, and all of our universal drawing tips apply to its 
drawing layer.

Reason 2: SuperPaint has been eclipsed by the other programs. Canvas and 
ClarisWorks are each far superior bargains and far superior programs in the 
paint-and-draw field.

Reason 3: SuperPaint is slow. We absolutely can’t stand the way when you 
zoom in, the actual-size view takes up half your screen. And when you’re 
zoomed in, everything in the draw layer is just as crude and jaggy-looking as 
art in the paint layer.

Sorry, SuperPaint fans — we just couldn’t see ourselves promoting this 
program’s cause in our own pages. 

end sidebar

M a c D r a w  S e c r e t s
Enclose touched objects with the 
Marquee
Under normal circumstances, you can only 
select objects you completely enclose with the
selection marquee (as you drag the Arrow 
tool). But if you ⌘-drag, you select everything 
even partially enclosed by the marquee (much
as just as you do selecting icons in the System
7 Finder).

Layer Secrets (MacDraw only)



The Option key is your key to objects lying on 
other MacDraw layers. For example, you can 
Option-click an object in an inactive layer to 
select it. You can Option-drag a selection 
rectangle to select all enclosed objects in all 
layers.

Drag more than just the outline



If you drag a selected object, you usually see 
only its outline during the drag. But if you ⌘-
drag it, you get to see the complete image as 
it’s being moved (see Figure 20-15).

Incidentally, the ⌘ key performs this function 
when you’re rotating or scaling an object, too.

Lock in that tool
Normally, a MacDraw tool doesn’t remain 
selected after you draw something (the arrow 
tool gets automatically reselected). If you 
double-click the Drawing tool to begin with, 
however, it turns black, and thus remains 
selected even after you draw.

Or, if the Arrow tool does reselect itself, you 
can just press Enter to reselect the most 
recent Drawing tool you used.

Selecting type with clicks
With the Text tool selected, double-click to 
select a word; triple-click to select a line; 
quadruple-click to select a paragraph; and 



quintuple-click (or press ⌘-A) to select all the 
text inside the block. 

(All but the quintuple-click business works in 
ClarisWorks, too.)

Power keystrokes (MacDraw only)

n ⌘-Option–A selects all objects in all 
layers.
n ⌘-Option–C copies one frame of a QuickTime movie to the clipboard.



n ⌘-Option–G switches between two modes of displaying gradient (blended) fills: the 
faster, cruder-looking one, and the higher-quality, slower-to-draw one.

n ⌘-Option–I flips you into and out of image-greeking mode. When greeking is on, all 
imported images and QuickTime movies appear on the screen as an empty box with an X 
through it. (That saves redrawing and recalculating time.) 

n ⌘-Option–M changes the zoom level to actual size. (⌘-left and right arrows halve and
double the magnification level with each key press.)

n ⌘-Option–P prints your document directly (one copy), without subjecting you to the 
Print dialog box.

n ⌘-Option–S switches the “Typing activates shortcuts” feature on and off. (MacDraw 
wants to know what you’re doing when you start typing. Are you typing the initial of a tool you
want to switch to? Are you beginning a new text block? If you want the former, turn on 
“Typing activates shortcuts.”)

n ⌘-Option–V pastes whatever is on the clipboard into the new scale of your document 
(if you changed it). (By scale, we mean 1 inch = one foot, for example.)

n ⌘-Shift–W brings the next window to the front (if you have more than one open).

n Page Up and Page Down scroll one screenful up or down. Option-Page Up and Page 
Down scroll one screenful right or left. 

See hidden keyboard shortcuts (MacDraw only)
Press and hold the ⌘ key when a dialog box is open on the 
screen. In small lettering, you see the keyboard shortcuts 
available in that dialog box, displayed right beside the 
commands they activate (see Figure 20-16).

We quite enjoy this last trick, by the way. We wouldn’t mind
if more programs adopted it, since it’s a quick and natural 
way to learn which keyboard shortcuts are available in one 
of these boxes. (Then again, we’re not quite so zealous as 
to claim that all programs already do have this feature, as 
we recently read in a certain rival Macintosh book!)



Canvas

Deneba’s Canvas program continues to get more densely 
packed with powerful features with every version. It’s a tough 
program to describe. It’s primarily a drawing program, but it 
has a nice set of painting tools so that you can paint on any 
object you draw. There’s even a set of PostScript drawing 
tools, too, giving you three bangs for three hundred bucks.

We don’t claim that Canvas is easy to use. On the other hand, 
we’ve almost never been run up against a brick wall in 
something we were trying to achieve. As such a feature-rich 
piece of software, it’s absolutely ripe with secrets.

C a n v a s  S e c r e t s

Save memory and loading time
Canvas’s modular construction means you can leave out 
pieces that you won’t need; each tool you omit saves 
memory and loading time. To select which features will 
load, hold down the Space bar just after you double-click 
the Canvas program icon. The Tool Picker will appear, 
showing a list of the plug-in tools you can double-click to 
switch on or off. Here are a few suggestions:

If you’re not exchanging files with IBMs, turn off CGM I/O, 
DXF I/O, IGES I/O.

If you’re not exporting or importing graphics from other 
programs, turn off Canvas 1.0 I/O, Canvas 2.0 I/O, 
Illustrator I/O, MacDraw I/O, MacPaint I/O, StartupScreen 



I/O, UltraPaint I/O.

If you’re running in black-and-white, turn off Dropper, 
Pantone Colors, RGB Color Manager, Separations.

If your graphic doesn’t contain text, turn off Bézier Text, 
Search & Replace, Spelling, Text Ruler, Text Utilities.



Conversely, if a feature isn’t working, you probably didn’t 
load the tool. You may discover that sometimes even a 
major menu command is dimmed: Align, for instance. Your 
first instinct should be to make sure you haven’t turned it 
off with the Tool Picker.

Keep the tool locked in
Exactly as with MacDraw, Canvas switches back to the 
Arrow tool after each object you draw. To switch back to 
the tool you just used, press ⌘ and start drawing. To 
permanently switch the auto-arrow selection feature off, 
choose Preferences from the File menu, click General, and 
select Retain Selected Tool. Now Canvas won’t change 
tools unbidden.

Quick removal and replacement of objects
If you’re in some complex tangle of objects, and some are 
getting in your way, here’s a quick way to toss them aside 
momentarily. Group them. Press ⌘-right arrow three times;
each time, the selected group will jump 10 pixels to the 
right. After they are out of the way, you can work on the 
remaining objects unencumbered.

When you’re ready to put the offending object group back 
in place, select it and press ⌘-left arrow three times. Not 
only do they jump back precisely to their original positions, 
but even their position in the front-to-back lineup remains 
intact. (If you press Option instead of ⌘, the selected object
jumps 50 pixels at a time instead of 10.)

Neat positioning of duplicates
That ⌘-arrow trick is also useful after you duplicate an 
object. The Duplicate command puts the copy in front of 
the original, 10 pixels down and 10 to the right. If you want
to pop it squarely back on top of the original, press ⌘-up 
arrow and ⌘-left arrow. Because the ⌘-arrow trick moves a
selection by 10 pixels every time, your duplicate will now 
be perfectly superimposed on the original.

Note that you can change the distance an object jumps 
when you press ⌘-arrow (using the Preferences command).



You can also change how far away a duplicate is placed 
from the original (using the Duplication command). In other
words, these last two Secrets only work if you haven’t 
changed Canvas’s default settings. 

Keyboard shortcuts
Here are the Canvas tools you can switch to without using 
the mouse:

To switch to this tool… …hold down these keys:
Dropper tool Option and Tilde (~)



Hand tool Space bar

Zoom tool (magnifying glass) ⌘-Shift-Option

Text tool ⌘-Option-T

Quick window jumping
If you have more than one window open, you usually switch
from one to another by choosing its name from the Window 
menu. Here’s a shortcut that can save you at least an inch 
or two of mouse motion: press Option and click the title bar
of any window. You get a pop-up menu listing the Canvas 
windows and palettes; choose the name of the one you 
want.

Pasting scaled screen shots
Wow, did we learn this the hard way!

Writing a book like this involves taking a number of screen 
shots (PICT files of the Macintosh screen). We reduce each 
screen shot to 60 percent of its actual size, so it won’t look 
ridiculously huge on a page.

Sometimes, though, we want to add an element to the 
image: an arrow or a caption, for example. We thought 
Canvas was a natural for this because its Text and Line 
tools are so good.

But whenever we pasted in a reduced-size graphic to 
Canvas, it wound up looking terrible (see Figure 20-18). 

Figure 20-18: If you paste a reduced-sized screen shot into Canvas, you get a 



blotchy mess (left). Unless you use our Secret (right). {Ed. note: You can’t really 
see the difference if you’re reading this on the screen; in the printout, you’ll see 
it!}

Turns out the Secret is not to use the Paste command at all. Instead, use the Paste 
Picture Object command (in the Edit Special submenu).



Hidden palettes
You probably haven’t even seen all of Canvas’s pop-out 
palettes. The Text tool, for example, has four. You control 
which pops out by holding down a particular key. 

Normally, if you hold the mouse down on the Text tool, a list
of text styles pops out. If you ⌘-click the tool icon, you see 
a list of your fonts. Shift-click it for a list of type sizes. And 
⌘-Option–click the icon to see a list of fonts displayed in 
their actual type faces.

Move a guide line and everything it touches
Adding and moving guide lines in Canvas works much as it 
does in page-layout programs. And you bring them onto 
your screen the same way: by clicking in the ruler and 
dragging into the drawing area.

Our Secret: Option-drag the guide, and any objects 
touching it will move along with it.

P h o t o s h o p  s e c r e t s

Quick before-and-after views in dialog boxes
Here’s one of the simplest but least-known Secrets: 
Whenever you make some adjustments in a dialog box — 
the Curves or Levels dialog boxes, for example — you can 
compare the new setting with the original by holding the 
mouse down on the window’s title bar. When you release 
the mouse button, the image snaps back to the new setting 
you made in the dialog box.

Two hidden information screens
The little file-size indicator at the lower-left corner of the 
screen conceals two different panels full of useful 
information (see Figure 20-8).

If you click on this indicator and hold the button down, you 



get the Page Preview (see Figure 20-9). If you Option-click 
here, you get a panel showing the dimensions, resolution, 
and number of channels for the active window.



Margin (unprintable)Current image areaPrintable area of the page

Chapter 21 (ResEdit)

R e s E d i t  S e c r e t s
Rebuild the System 6 Desktop and preserve 
comments
Much as this Secret’s name appears to be an oxymoron, it’s
true. You can rebuild your invisible Desktop file (see 
Chapter 1) without losing all the comments you’ve typed 
into the Get Info boxes of your files. (This trick, alas, works 
only on System 6.)

Launch ResEdit. Open the Desktop File (at the outer level 
of your hard drive). Save a copy of it with a different name. 
Then rebuild the desktop, as described in Chapter 1. Open 
the copy of the earlier Desktop File with ResEdit. Select the
FCMT (Finder comments) resource, copy it, and paste it 
into the new Desktop File. Your comments, are back!

The built-in screen-font editor
ResEdit’s font editor doesn’t affect the printouts if you’re 
editing a TrueType or PostScript font. ResEdit only changes
bitmapped fonts and the on-screen portion of outline fonts. 
For more serious font-editing work — and to edit the 
printer fonts too — you need more serious tools, such as 
Fontographer. (For an introduction to fonts, see Chapter 
24.)

If you do a lot of manuscript reading on the screen, you 
may wish to touch up a certain punctuation mark or letter 
to make it easier to read. Here’s how you do it:



Launch ResEdit. Open the font file you want to edit. 
Double-click the NFNT resource. In the window that 
appears, double-click the specific style and size whose 
screen font you want to edit. You’re warned not to change 
the widths or heights or characters — only to change the 
look of the actual character. ResEdit’s font editor opens 
(see Figure 21-20). 



To select a character to edit, just type it on the keyboard. 
You can also drag sideways through the displayed letters at
lower-right. Then use the painting tools to change the look 
of the letters. Save your changes and quit ResEdit. Keep in 
mind that you have to edit each size of the font separately.

Actually, we draw your attention to this secret only half-
heartedly. Fact is, ResEdit’s font editor has some problems, 
especially with System 7.1. For one thing, you have to turn 32-bit
addressing off to use the ascent, descent, and character limit 
controls. Even then, the sample text window doesn’t always show
the correct font. (Notice this weirdness reflected in our screen 
shot.) 

Figure 21-20: ResEdit’s 

built-in screen-font editor.
Is it 32-bit clean? 
If you read Chapter 8, you know that some programs can 
run with 32-bit addressing turned on, and others can’t. (32-
bit addressing lets your Mac use more than eight 
megabytes of memory.) But how can you tell, short of 
risking a system crash by trying it?

Easily. Open the application you want to examine. Open the SIZE 
resource icon; then double-click the –1 item. Scroll down until 
you see the “32-bit compatible” item (see Figure 21-38). If it’s set
to 1, then you’re okay. If it’s set to zero, that program may not be
32-bit clean. (It won’t necessarily crash in 32-bit addressing; it’s 
just that nobody’s yet confirmed its 32-bit cleanliness.) And no, 
you can’t make a program 32-



bit compatible by changing this indicator from a zero to a 1!

Building a better Alarm Clock

Let’s face it: the Alarm Clock is a drab desk accessory. With
a little ResEditing, you can make it a lot prettier. 

Open the Alarm Clock with ResEdit. Open the WIND 
resource. Double-click the only resource contained within 
(number -16000). Select a new window type. The bordered 
window without a title bar looks great. 

While you’re at it, select the Custom radio button and add a new 
border color and content color. The content color will appear as a
thin frame of color just inside the window border. If you feel 
ambitious, copy the solitary PICT resource into a paint program 
and colorize the clock, alarm, and date icons; then paste them 
back in. You end up with a flashy-looking alarm clock that works 
just as it did — but is much more attractive on the desktop (see 
Figure 21-42).

Changing date formats
Some folks get annoyed that under System 7.0 and 7.0.1, 
the Finder’s list views use a full version of the creation and 
modification dates for your files. You don’t see 2/5/94; you 
see Saturday, February 5, 1993, 9:47 A.M.

Not only is that more information than most people need, 
but it crowds up list-view windows. Fortunately, you can fix 
all this with ResEdit. In fact, you can transform the date 
info displayed in the Finder into just about any format you 
prefer. (In essence, you can do with ResEdit what the Date 
& Time control panel does for System 7.1.)



Open a copy of the System file with ResEdit and open the 
itl1 resource icon. (Watch closely; there are also itl2, itl3 
and itl4 icons.) It contains a single resource, called U.S., 
with an ID of 0. Open it.

Now adjust the settings in the window to reformat the date. You 
can suppress any element of the date, such as the day of the 
week or the year, by checking the appropriate checkboxes (see 
Figure 21-54). You can use the pop-up menus to shift the order of
the elements (changing day-month-date-year to day-date-month-
year, for example). You can also change the punctuation that 
appears between each element (you can separate the month and 
date with a dash instead of a comma). You can even change the 
names of the days and months, if you are so inclined.

When you’ve made the 

needed adjustments, save the changes before quitting ResEdit. 
Any program that has a date-stamp feature, such as Word, will 
use your new date format. And, of course, the Finder will, too 
(see Figure 21-55). 

Eliminating the rename delay
When you click on the name of an icon, System 7 pauses 
momentarily before activating the name’s selection box so 



that you can edit it. The 



rename delay is there supposedly to prevent you from 
accidentally renaming an icon you meant to open. 

As we mentioned in Chapter 1, you can change this 
renaming-delay by adjusting the double-click setting in the 
Mouse control panel. At least you could until System 7.1 
came along.

This version of the system requires ResEdit to change the 
rename delay. (In fairness, System 7 Pack, included with 
this book, does this trick with much more efficiency; see 
Chapter 33.) 

It’s easy to eliminate this delay. (This little hack, however, 
doesn’t work with System 7.5.) Open a copy of the Finder 
with ResEdit. Open the CODE resource icon and find the 
resource with ID number 11. Open this resource and 
choose the Find Hex command in the Find menu.

In the Find Hex field, type 5DC0. In the Change To field, type in 
50C0, exactly as shown in Figure 21-56. (Those are all zeros, not 
letter Os.) Then click the Change All button.

You can perform this same 

change by searching for the 5DC0 hex string, selecting it, and 
manually typing in the new code, as shown in Figure 21-57. 
However you do it, save the change when you’re done. Restart 
your Mac with the modified Finder installed to see the results.
Change this... ...to this

Fatten the PowerBook cursor

The Mac’s narrow I-beam cursor can be hard to see —  
especially on a PowerBook. So why not fatten it up a bit 
with ResEdit?

Open a copy of the System file using ResEdit and open the CURS
resource. You’ll see a window displaying the various cursor 
shapes used by the System. Double-click the I-beam to open an 
editing window, as shown in Figure 21-58. Now, just use the 
drawing tools to thicken up the vertical beam, adding an extra 



column of pixels on each 



side. When you’re done, close the window.

Next, open the ROv# resource and open 

ID 1600. Scroll to the very bottom of the window and click in the 
last item — a row of five asterisks. Choose Insert New Field(s) 
from Resource menu. This adds two new fields in the window — 
Type and ID.  In Type field, enter CURS and in ID field, enter 1, 
exactly as shown in Figure 21-59.

When you restart your Mac 

with the edited System, you’ll have a chunky and easy-to-spot 
cursor. 

Making a StartupScreen 
Making a custom startup screen for your Mac normally 
involves using a graphics program that saves a file in a 
special StartupScreen format. But with ResEdit, you can 
transform any PICT image into a startup screen. Here’s 
how.

Create the artwork you want to use as a startup screen. 
(You can use a graphics or painting program, the painting 
tools in HyperCard, the drawing tools in Word, or some clip
art. Or you can use Color-It, the full-blown 24-bit color 
painting and image-editing program that came with this 
book.) Copy it to the Clipboard.



Then launch ResEdit. Choose New from the File menu. 
You’re asked for a title; call it StartupScreen (no spaces), 
and save it into the System folder.

Next, choose Create New Resource from the Resource 
menu. The Select New Type window appears, in which you 
must indicate the type of resource you want to add to the 
file. Double-click PICT from the scrolling menu or just type 
PICT into the text field and press Return.

There’s a new, empty window on the screen. Choose paste 
(⌘-V) from the Edit menu to place your copied graphic into 
the window. If it’s a large image, you won’t see all of it; 
that’s okay.

Now, choose Get Resource Info from the Resource menu. In
the window that appears, change the ID number from 128 
to 0. Save the change and quit ResEdit.

When you next start up your Mac, you’ll see your 
customized graphic in place of the “Welcome to Macintosh”
message!

Chapter 22 (Utilities)
Super Boomerang

The crown jewel of Now Utilities (not the component that 
comes free with this book, obviously) is Super Boomerang.

Super Boomerang adds a menu bar to your Open File box. It 
offers File and Folder menus that list the last 30 or so files and
folders you opened. What's more, Super Boomerang doesn't 
automatically highlight the first file in the list, as the Mac 
does; instead, it highlights the file you opened most recently.

Finally, Super Boomerang gives every program's Open menu 
command a pop-up menu that lists the most recently opened 
files.
The other utilities

The remaining utilities include WYSIWYG Menus (included with this book; see Chapter 
34); Now Menus, which lets you assign a keystroke to any menu item in any program, 



adds a launch menu to your menu bar, and more; NowSave, which automatically saves 
your work at predefined intervals (and can create a backup text file containing 
everything you type); Startup Manager, an extensions-and-control-panels manager (see 
"Extension managers," below); Now Scrapbook, a replacement for your Apple menu 
Scrapbook with keywords, sorting, exporting to various graphics formats, and even 
some basic graphics-editing tools (crop and 



resize); and Now Profile, which reports on your Mac's model, configuration, and 
installed software.

Font-management utilities

Apple’s old Font/DA Mover was one of the most grave 
violations of the Mac’s “computer for the rest of us” ease of 
use. So programmer Steve Brecher wrote Suitcase, and the 
world has never been the same. System 6, in particular, isn’t 
complete without this program. It lets you install and remove 
fonts instantaneously. You don’t have to restart the Mac, and 
you certainly don’t have to use the Font/DA Mover. 

System 7’s revamped font-installation scheme makes life with 
fonts much easier, and lessens the urgency of a font manager 
like Suitcase. We cover Suitcase and fonts in greater detail in 
Chapter 24.

U t i l i t y - s o f t w a r e  S e c r e t s

Defeating the submenu
Now Menus automatically adds a submenu to any folder or 
disk listed in the Apple menu, so that you can see its 
contents. It also adds one to any application listed there, so
that you can launch any recently opened documents.

Sometimes, though, this submenu gets in the way. For 
example, when you launch ResEdit, you don’t generally 
care about recently opened documents; you’re only 
interested in whatever you’re about to open.

To turn off the submenu for an individual item in the Apple 
menu, just highlight it with the cursor and press the Space 
bar. (Press Space again to make the submenu return.)

Solving the mysterious After Dark crashes
We didn’t know where else to file these particular bug 
reports. But we’ve never seen it in print, so we wanted the 
world to know.

Performer, the bestselling MIDI music recorder/editor, 
gives thousands of musicians the impression that it’s an 
incredibly buggy piece of work. It freezes every five 



minutes, on the dot.

Well, there’s a good reason for that: it conflicts with After 
Dark (which, of course, typically comes on about every five 
minutes). Actually, it only conflicts with After Dark’s 
sounds. So the solution isn’t too difficult: just turn off your 
screen saver’s sounds, all of them.

Furthermore, After Dark strikes many people as being 
incompatible with the Centris and Quadra models: in 
conjunction with Word, MacWrite Pro, and other programs, 
After Dark crashes. The solution is to call Berkeley Systems
and get an upgrade to version 2.0.x or later. 



(The letter X should clue you in that new After Dark 
versions are introduced frequently. If you buy a new Mac, it
pays to keep up.)

Art of Darkness Secrets
You can add modules to your collection of After Dark flavors
in a number of ways. One module is More After Dark, from 
Berkeley Systems. Another is the book/disk combo Art of 
Darkness.

This latter book contains a module called Fractal Forest. 
Set it to Winter, set your Mac clock to December 25, and 
enjoy (see Figure 22-12).

Incidentally, Christmas trees that appear on December 25 
are a time-honored Mac hidden-surprise tradition. The 
classic Mac games Airborne and Dark Castle also have 
special surprises in store when you play them on Christmas
Day (and so does Maelstrom, the outstanding shareware 
space arcade game).

Screen shots of screen shots
We’re sure this next one will hit home with all of two people
in the whole world. But it hit home with us: How do you 
take a picture of a screen-grabber program? For example, if
you’ve got Screenshot’s floating palette on the screen in 
readiness for taking a screen shot, how do you take a 
picture of it?

No, you can’t use System 7’s ⌘-Shift–3 to take the shot; it 
doesn’t operate when a screen grabber’s palette is on the 
screen. The only way to do it is to duplicate the screen-
grabber control panel. Give them different names, and give 
them different trigger key combinations. Then, when one’s 



on the screen, invoke the other to capture it!

A blue tint to Screenshot shots — or transparency
Here’s a Secret for Screenshot, the screen-grabber 
program from Baseline Publishing. In the early years of 
Mac magazines, published screen shots had a faint bluish 
tint to them. You add this tint to any screen shot you take if 
you press Option while clicking any of the four capture 
buttons. (If you use the Selection button, hold Option until 
you finish dragging across the screen.)



Otherwise, white areas of the screen you’re capturing will 
be given a white color in the resulting PICT files. But if you 
press ⌘ while capturing a screen image, the resulting 
image will turn what was white on the screen transparent 
in the captured image. Using this technique, you can paste 
the screen shot on top of a light tint of any color that you 
laid down in advance in a painting program.

begin sidebar: Answer Man

What’s verify after writes?

Q: This guy at the office got into a big fight over which program does file 
compression better. He kept saying that the faster program shouldn’t really 
count, because it didn’t verify after writes. What’s he talking about?

A: File verification is a hot buzzword among file-compression nuts. When a 
compression program “verifies after writes,” it essentially checks its work. It 
compares the compressed version of the file that it just “wrote” onto the disk 
with the original; technically, it uses a checksum. It checks to make sure that 
there were no errors in storing the compressed file (caused by a bad spot on 
the disk, for example).

As you can imagine, this double-checking process makes the overall 
compressing take longer (perhaps 20 percent longer). It’s safer, though, 
especially if you’re compressing the file onto a potentially flaky disk like a 
floppy or a removable cartridge. 

The guy at the office was right, by the way. You can’t compare the 
compression speeds of two programs if only one of them is verifying after 
writes.

end sidebar: Answer Man

Hard drive in a menu
Now Menus lets your Apple menu become a hierarchical 
table of contents for any folder listed there. But why stop 
there? Put an alias of your hard drive into the Apple Menu 
Items folder (in the System folder). Now Menus shows you 
its entire contents, popping out as submenus and sub-
submenus from the hard drive’s name in the Apple menu.

No-fuss unstuffing with StuffIt
If you have StuffIt (Lite or Deluxe) on your hard drive 
somewhere, here’s a time-saver. Normally, unstuffing 



something involves several 



steps, including double-clicking the files you want to 
extract, naming (and choosing a folder for) them, clicking 
OK, and so on.

You can turbocharge the whole process by holding down 
the Shift key after you’ve double-clicked the archive icon in
the Finder. (If you haven’t yet registered your version of 
StuffIt Lite, then press Shift after you click the Not Yet 
button in the opening dialog box.)

Or, if you’re already in the program, use the Open 
command, and then press Shift just after you double-click 
the name of the archive you want to open.

Your name in lights
Compact Pro is a shareware program. When you send in 
your money, you register your copy of the program. And 
that’s not all: if you choose About Compact Pro from the 
Apple menu and wait a moment, you see your name scroll 
past, surrounded by diamonds.

Stepping Out
This is among the cleverest and weirdest of the Mac screen
utilities (from Berkeley Systems [Ed. note: we don’t think 
they sell it anymore]). It sets aside a large chunk of 
memory to use as a virtual screen. That is, it tricks your 
Mac into thinking that it’s got a huge monitor. The actual 
glass of your real monitor becomes just a movable window 
onto the much larger virtual display. To pan around the 
virtual monitor, you push your cursor into the edges of your
actual screen. The hidden area of the virtual screen scrolls 
into view. (This is a great advantage to the unfortunate 
owners of the Apple 12"  monitor, upon which many games 
either won’t run or lose important parts of their interface. 
With Stepping Out, the Mac thinks it has a bigger screen, 
and you can scroll the hidden portions into view.)

Here’s the tip: If you find an application that’s incompatible
with Stepping Out, press Option while it’s starting up. 
Stepping Out will disable itself. Use the Stepping Out 
control panel to turn the virtual screen back on.



Screen savers on PowerBooks
You don’t need them. (Screen savers, that is, not 
PowerBooks.) A PowerBook LCD screen can’t get burn-in 
syndrome like a regular CRT computer monitor (see 
Chapter 10 for more on monitors). If you do leave the 
backlighting on for more than 24 hours, you may get some 
faint persistence of the image, but it’s temporary. It goes 
away again after the screen is dark for awhile.

But After Dark and Sunset are great on any monitor for 
their fun factor alone (especially on a PowerBook with an 
active-matrix color screen!). 



If it enhances your prestige on the flight to London, then 
run a screen saver by all means.

Log on once a day only
There are some automatic tasks, such as checking your e-
mail, that you probably want to take place only once each 
day. Of course, it’s easy to create a macro that runs each 
time you turn on the Mac; even QuicKeys can do that. But if
you turn on your Mac several times in a day, such a macro 
fires itself too many times. This trick lets you trigger a 
macro just once each day, regardless of how many times 
the Mac is subsequently restarted.

The solution is to set a “flag” for itself that says “Today, I 
have performed this task.” Each time the Mac starts, a 
macro checks to see if the flag has been set. If it hasn’t, it 
runs the macro and sets the flag. 

Assign the macro you want to be run only once per day — 
we’ll call it E-mail Check — to a Tempo Autoboot, which 
you put into your System 7 Startup Items folder. (Under 
System 6, select the Autoboot icon, then choose Set Startup
in the Finder’s Special menu, and set the Mac to run the 
Tempo Autoboot when it starts up.) 

On startup, the first thing E-Mail Check does is branch to a 
macro called Eval(checked yet?=date). If the answer is no, 
which means that the variable called checked yet? doesn’t 
contain today’s date, then Tempo branches to your “Log on 
and download E-Mail” macro. Then Tempo branches to one 
more macro, called “checked yet?=Eval(date)”. This sets 
the value of checked yet? to today’s date. 

If the Macintosh restarts during the current day, the same 
thing happens again. But this time, the value of checked 
yet? does indeed equal the value of “date,” so Tempo 
doesn’t run the “Log on and download E-Mail” macro.

Tempo can actually make further tests as part of this 
macro. If you want the logon macro to run only on 
weekdays, for example, Tempo can also test to see if 
today’s day of week starts with an S. If it does, that means 
it’s a Saturday or Sunday, and your macro gets the day off.



Open a cranky control panel with QuicKeys 
There are a couple of ways to open a control panel’s panel 
directly without the bother of choosing Control Panels from
the Apple menu and double-clicking an icon. First, you can 
define a File QuicKey to open it directly. Second, you can 
use the Panels Extension to do the same thing.

But these macros may not always work. You may run into 
trouble trying to open a file over a network using one of 
these macros. The 



surefire solution is to use a Finder Events macro (one of the
Extensions). Use its Open option to specify a control panel 
(or any file at all) that you want to open.

Hide-application macros
Here are a couple of our favorite QuicKeys. Define one key 
to hide the frontmost program by choosing Hide 
ClarisWorks (or whatever) from the application menu. 
Define another one to choose Hide Others from the same 
menu. It works like a charm! 

QuicKeys also has predefined macros (in the Extension 
called Process Swap) that can shuffle between multiple 
running System 7 programs. With one keystroke, for 
example, you can jump back to the last program you were 
in, or to the next program in the list — and you have the 
option to auto-hide the program you’re switching out of!

Instant Fax/Modem switching
Most of the software that comes with today’s fax/modems 
works like this: when you want to fax the document that’s 
on the screen, you press Option or the ⌘ key while pulling 
down the File menu. Everywhere it usually says Print, it 
now says Fax (Fax Setup, for example). 

Some of the less elegant fax/modems (and network 
modems), on the other hand, come with software that 
requires you to open the Chooser and click the fax/modem 
icon to send a fax. That’s a lot of trouble — and QuicKeys 
can take care of it. 

Use the Choosy extension, which comes on the QuicKeys 
disks. It has one purpose in life: to switch Chooser-
selectable drivers (icons) at the touch of a key. You don’t 
even have to open up the Chooser to do it. (Set up a second
macro to switch back to your regular printer after you’re 
done faxing.)

The best floppy-saving program in the world
We’re about to reveal what we consider one of the truly 
best-kept secrets in the Mac industry. (We’re not being paid



by any of these companies, by the way.) This is a program 
that can salvage the files from almost any bad floppy disk. 
It’s an aging, underpublicized piece of software. But we’ve 
used it hundreds of times on disks that the Mac insisted 
were “unreadable.” Old disks, new disks, 400K disks, high-
density: this program can save almost all of them. 

It’s called 1st Aid HFS (not to be confused with Apple’s 
Disk First Aid). Unfortunately, because it’s such a well-kept 
secret, it got rolled into a package called 911 Utilities, 
which included Virex, the anti-virus program. And then that
got rolled into a package called SuperSet, which includes 
still other programs (like the Citadel security 



program). The company that made the program has been 
similarly gulped up a couple of times by other companies.

At this writing, anyway, the company responsible is now 
called Datawatch, and the package is called SuperSet — 
and buried deep, deep inside it is the Number One floppy-
disk recovery program in the world.

V i r u s - p r o t e c t i o n  S e c r e t s

Kill the WDEF virus
One of the most frequent virus attacks (if such attacks can 
even be called frequent) is that of the WDEF virus. It’s as 
easy to kill as they come: just rebuild the desktop, as 
described in Chapter 1. Furthermore, System 7 is immune 
to this virus.

Chapter 23 (Speech, Sound, Movies)
Notes on the AV models
Speech Recognition

The primary pair of controls in this control panel are the On/Off switch and the 
tolerance slider.

The On/Off buttons, of course, switch speech recognition on or off; the salient point 
here is that the On option gulps down the 2.5MB required for speech recognition to 
work. (Click Off to regain that memory instantly.)

The Tolerant/Strict slider is the single most important setting for getting good results 
from speech recognition. Set the slider toward Strict if you work in a noisy 
environment; the Mac will execute a command only if it’s pretty darned sure what you 
uttered. If the Mac seems to be ignoring you completely, set the slider toward Tolerant.

The Options pop-up menu

This pop-up menu lists four setup options:

n Introduction. Choosing this option reveals the Introduction button, which, when clicked, 
launches the Introduction program (stored elsewhere on your hard drive). This screen is important reading; 
follow it all the way through. The tour is more fun if speech recognition is on so that you can try the little 
lessons.

n Name. You’re generally supposed to address your computer by prefacing each command 
with its name: “Computer, empty the trash,” for 



example. The idea is to prevent the Mac from going wild, pulling down menus, and so on, when you’re just 
talking on the phone.

Use this option to indicate what name you want to use and how strict you want to be about 
having to use it. The name must contain more than one syllable, and it has to be a pretty straightforward 
word or phrase. (Added fun: Try “Simon says.”)

n Feedback. The name that you choose for your computer has nothing to do with the 
Character that you choose as your Feedback persona (see Figure 13-9).

This option allows you to control how the Mac talks to you, both visually and aurally. The 
Character pop-up menu lists the little cartoony guys shown in Figure 13-10. The image that you choose will 
float on your screen in a little window, acting perky, sleepy, or confused, depending on how the Mac is reading
you.

M a c - t o - T V  S e c r e t s

Make your own movie stills
As “Roseanne” plays away on your screen, don’t forget that
you can take a snapshot at any time simply by choosing 
Copy from the Edit menu (or by pressing ⌘-C). (This works 
in most video-showing programs, such as VideoMonitor and
Apple Video Player.) The Mac saves the frame that it 
grabbed from the screen as PICT 0, PICT 1, or whatever 
(unless you changed your Preferences). Feel free to edit the
resulting picture in, for example, Color It, which comes 
with this book and is ideal for, say, editing your ex-spouse’s 
head out of a captured frame of your Thanksgiving footage.

Why your movie is only .02 second long
If you use the VideoFusion program to record a QuickTime 
movie, your first experience is likely to be short and very 
disappointing. Sure, you can preview the incoming TV 
picture (provided that you switched down to 256 colors, as 
described earlier). But VideoFusion stops recording almost 
immediately!

The problem lies in VideoFusion’s Record Preferences (in 
the Record menu). The default option is “Record to 
memory, then write to disk” — meaning that VideoFusion 
will record only as much movie as it can store in your Mac’s
current free RAM, which probably is only a second’s worth 
(unless your computer is endowed with extra RAM).

If you choose “Record directly to disk” instead, you’ll be 
able to record much longer movies. Unfortunately, you’ll 
also get much choppier movies; recording straight to the 



hard drive gives you the jerky low frame rates that you’d 
normally associate with less AV-savvy Macs.



The solution, of course, is to get a lot of memory and enjoy 
the higher frame rates — or to forgo VideoFusion 
altogether and buy a real QuickTime production product, 
like VideoSpigot or VideoVision. (Make sure that the 
product will work with your specific model. For example, a 
Power Macintosh 6100 with the AV card can’t accept an 
additional NuBus card.)

The magic keystroke for TV as a monitor
You’ve traveled thousands of miles with your Quadra AV to 
give a demonstration. You’ve been counting on using a TV 
as a screen. You hook it up, turn on the Mac — and get a 
staticky mess. You remember that you were supposed to 
tell the Monitors control panel that you’d be using a TV 
while you were still connected to a regular monitor!

You’d be sunk if you didn’t know this trick. Restart the Mac;
as it starts, hold down the ⌘, Option, T, and V keys. Your 
Mac automatically switches to using the attached TV as its 
screen.

Fortunately, the Power Macs are smart enough to detect 
when no Mac monitor is attached and to switch to the TV 
automatically.

The 512-by-384 miracle
When you try putting your Mac’s image on TV, you’ll notice 
one problem: everything’s tiny. Normal-size text is too small
to read. Your menus are barely visible at the top of the 
screen. Worse, your QuickTime movies — which usually 
aren’t full-screen to begin with — look positively puny, 
desolately stranded in the center of your yawningly big TV 
screen. But we know a great trick.

While the picture is displayed on your Mac monitor, open 
the Monitors control panel, click Options, and select the 
512 x 384 monitor setting. When you click OK (Power Mac) 
or close the control panel (Quadra), you’ll see a startling 
sight: your normally glorious full-screen picture now is a 
tiny, tunnel-vision, nine-inch picture in the center of your 
screen.



Terrible, you say? Not for our purposes. Go back to the 
Monitor control panel’s Options window. Switch to 
displaying the picture on TV, as described earlier. Now the 
picture is bigger on the TV screen, making it truly easy to 
read text, restoring your menu bar to clarity, and making 
any centered QuickTime movie fill much more of the 
screen!

sidebar: Answer Man



A galaxy of extensions

Q: Good God — what on earth are all these extensions and control panels? 
Can’t I get rid of some of ‘em?

A: If you really want to know exactly what they are, read Chapter 3.

We can tell you this much here: each AV feature requires its own phalanx of 
System Folder junk. Sure, you can throw some things out — a dozen at a time,
in fact — if you don’t need one feature or another. Here, for the record, is what
you get for each AV aspect:

CD-ROM drive: Apple CD-ROM, Apple Photo Access, Audio CD Access, CD 
Remote Init (older systems only), Foreign File Access, AppleCD Audio Player, 
High Sierra File Access

GeoPort Telecom Adapter: Express Modem Tool, Fax Extension, Fax Sender, 
GeoPort™ Extension, GeoPort™ Telecom, Shared Library Manager, Express 
Modem control panel

Speech recognition: AppleScript, Apple® Event Manager, PlainTalk™ 
Speech Recognition, PlainTalk™ Text-To-Speech, QuickTime™, Serial Extension,
SR Monitor, SR North American English, System Speech Rules, TTS Female 
Voice, TTS Male Voice, TTS Male Voice Compressed, Speech Setup control 
panel

4end sidebar 

Why your old monitor doesn’t work
The Quadra AV and Power Macintosh AV models have one 
common feature that we haven’t yet mentioned — a feature
that you’ll probably wish these models had. Neither the 
Quadra AV nor the Power Mac AV works with many pre-AV 
monitor brands.

In the past, a controlling signal — known as the sync signal 
— was sent to your monitor on the same wire as the signal 
for the color green. But during the development of the 
Quadra AV, Apple changed the signal. Any older monitor 
that expects that sync-on-green signal won’t work.

Sometimes, you can get your monitor to work by obtaining 
a new cable or NuBus card from the manufacturer. 
Otherwise, you’ll simply have to sell your monitor and 
replace it with one that’s AV-compatible.

The secret movie for Quadra AV owners
If your Quadra AV has a built in CD-ROM drive, try this. 



Insert the CD InstallMe First disc into the drive; then 
launch the Simple Player (or another QuickTime playback 
program). Choose Open from the File menu. Open the CD’s 
System Folder, and open its Preferences folder. Then find 
and play the file called Our Gang — a long, dull, 



self-congratulatory movie of the AV Hardware design team 
toying with circuitry.

HyperCard

What a roller coaster ride! First Apple included HyperCard 
with every Mac. Then Apple handed it over to Claris, who 
began selling it for $200, and Apple still gave it away with 
every Mac. Then Apple stopped giving it away with every Mac 
and created a stripped-down, playback-only version called 
HyperCard Player. Then Apple took HyperCard back from 
Claris, enhanced it with color, variable window sizes, and 
other goodies, and re-released it as HyperCard 2.3.

If you want to learn to program HyperCard, we merrily refer 
you back to your bookstore bookshelf for entire books devoted 
to the topic. Nonetheless, we’ve acquired a few tasty morsels 
to pass along. 

H y p e r C a r d  S e c r e t s

The Magic password
As we mentioned, for a time there were two versions of 
HyperCard: the free one distributed by Apple and the $200 
one distributed by Claris.

As it turns out, there was no difference between the two 
versions! The free version was temporarily crippled when 
you first got it, but the following trick instantly changed it 
into the full, working, Claris programmable version:

Launch HyperCard. Go to the Home stack (⌘-H). Press the 
left arrow key to go to the Preferences card. Press ⌘-M to 
bring up the Message box. Type magic and press Return. 
Suddenly, the two final user levels, 4 and 5, spring into 
view! If you click level 5, you unlock your copy of 
HyperCard.

Of course, after sly Mac authors like us started spreading 
the Secret, Apple and/or Claris promptly took the secret 
out! The version that accompanies all current Macs, 
HyperCard Player, can’t be turned into the full version. No 
way, no how. (We’re not even sure why it’s included at all, 



because it doesn’t come with any stacks to play with!) 

More about the Message box
The Message box in the last Secret is a powerful channel 
directly into the heart of HyperCard. Here are some of the 
commands you can type into the Message box. Remember, 
press ⌘-M to bring the box onto the screen and press 
Return at the end of the command.



s Opens the Stack Info dialog box.

b Opens the Background Info dialog box.

c Opens the Card Info dialog box.

nav Opens the Navigator palette, containing shortcuts
for the navigation commands in the Go menu.

Keyboard shortcuts
If you’re in Button or Field-editing mode, press Tab to 
switch back to Browse mode.

Press ⌘-Option to make a dotted outline appear around 
every button on the current card. This is a great trick for 
making sure you’re not missing some of the fun by failing to
click something. (Hidden buttons, however, remain hidden; 
they’re only outlined when you’re in Button mode.)

⌘-Option–click a button to open its script instantaneously. 
Press ⌘-Option–Shift to display a dotted outline around 
every field and button.

Your name (and Mac) in lights
HyperCard 2.1 has one handy and one goofy feature in one:
the About box. Press the Option key as you choose About 
HyperCard from the Apple menu. As you see in Figure 23-
11, HyperCard credits you with having authored the 
program. 

How does it find out your name? From the Sharing Setup 
control panel if you entered your name there. (If not, you 
see instead the name of one of the actual programmers.) If 
your name doesn’t appear, try again; with each attempt 
you’ll see somebody else’s name —  and, eventually, yours.

In the main part of the dialog box, you also see a number of
interesting specs concerning your Mac.

Externals for a better world
One of the best parts of HyperCard is the externals, or 



XCMDs, that serve as plug-in features for your stacks. They
can make your stacks do things you could never program 
them to do yourself: control laser disc players, create pop-
up menus, and so on. You can get externals from on-line 
services, by mail order, and from Mac user groups.

Be careful if you decide to distribute your stacks, however; 
some of the externals have strict licensing limitations. On 
the other hand, you 



can often find freeware or shareware externals that do 
exactly the same thing as a commercial one.

What system software version?
Here’s a handy little undocumented function that tells you 
the current Mac’s version of the System. (You can use this 
in either the message box or in a script.) It’s 
systemVersion(). 

If you type this into the Message box, the version number 
appears as soon as you press Return.

Open a new window
You’re probably used to thinking of HyperCard as a one-
window show. As soon as you open one stack, the preceding
one disappears.

Not so! Press Shift when you open a new stack (or use the 
Recent window to go to another stack). The new stack 
appears in its own separate window.

Unhide the menu bar (or keep it hidden!)
Some stacks that come your way may hide the menu bar! 
You can’t use any of the normal HyperCard commands — 
unless you know the secret keystroke to bring it back into 
view (or unhide it): ⌘-space bar.

Of course, you, the HyperTalk whiz, can block those 
ungrateful users from showing your menu bar if you’re 
really bent on keeping it hidden. Just use this script in your 
stack:

on show what
 if what ≠ “menubar” then pass show
end show

Hide and show the palettes from the keyboard 
When any painting tool is selected, press Tab to show the 
Pattern palette (or hide it if it’s already open). And no 
matter which tool is selected, you can hide and show the 
regular painting tools palette by pressing Option-Tab.

Fun with your built-in synthesizer



No wonder they call HyperCard a natural for multimedia. It
can play recorded sounds. It can play movies. Now we’ll 
show you how to play its built-in electronic keyboard.

It’s a simple one, to be sure. You have to preprogram every 
single note, and that’s all it can play — single notes. But it’s
fun. You can put this programming either into a button 
script or directly into the Message box.



You use the command Play. Follow it with the instrument 
name in quotes (turn off your curly-quotes feature!); the 
default HyperCard instruments are Boing and Flute, but of 
course you can record and insert your own instruments.

After that, you just specify which notes and rhythms you 
want. You can use the regular notes of the scale, A, B, C, 
and so on, or note numbers (middle C is 60, 
C-sharp is 61, and so on); following each note name, you 
can put a number representing which piano octave it’s 
supposed to be in (the middle C octave is 4). You can use 
the first letter of each rhythmic value to specify note 
lengths: q is a quarter note, w is a whole note, and so on. 
To make a rest, put the value-letter followed by an r (a 
quarter-rest, then, is qr); to make a dotted note, type a 
period (a dotted-half note is h.), and to make a triplet type 
the rhythmic value followed by a 3 (so a triplet sixteenth-
note rest is s3r).

Here, then, is how you’d listen to “Mary Had a Little Lamb”
on the flute. Note the shorthand: if the octave or the note 
duration stays the same on two consecutive notes, you 
don’t have to repeat that information in the next one.

play "flute" e4q d c d e e eh dq d dh eq g gh
Now you’re a HyperCard soloist! Go to town.

Salvage a corrupted stack
Corrupted cards may make it impossible for you to page 
through a stack. If so, you can copy and paste the cards one
by one into a new stack. 

Then, when you get to the card just before the one causing 
the problem, type the following command into the Message 
box: go card the number of this card + 2. This lets you skip 
the card or cards that are corrupting the stack. 

Editing Sounds with HyperCard 

If you bought your Mac between 1990 and 1992, you probably 
got a copy of HyperCard. Note: This doesn’t work with 
HyperCard Player, the program that comes with all Macs after 
September 1992.



Along with the full version of HyperCard (versions 2.1 and 
later) are two stacks that work wonderfully with sound: 
Appointments With Audio and Addresses With Audio. You can, 
of course, record new sounds directly into these stacks: 
“Lunch with Bill on Thursday,” and so on. That’s probably what
these stacks were designed for.



But you can ignore the address and appointment features and 
still use HyperCard’s powerful sound-editing window. Open 
any stack. Then choose Audio from the Edit menu. The floating
palette shown in Figure 23-2 appears.

Figure 23-2: In the foreground, you see HyperCard’s sound-recording palette.

The recording controls here work just as they do in the Sound control panel. However, here you 
have a choice of sound quality: Best (22KHz) or Good (11KHz). (For the record, the Sound control
panel records at 22KHz.) 

Into the cutting room

More importantly, you can click the Edit button in the upper-right corner. A terrific 
sound-wave-editing window appears (see Figure 23-3).



The blotch you see in this window is a graph of the sound wave over time. The taller the
squiggle, the louder the sound. Drag across a portion of this graph and click Play, and 
you hear only that portion. Using this technique you can actually pick out specific 
words from the recording (see Figure 23-4). From a civil rights standpoint, this could 
actually be a dangerous feature!

Figure 23-4: Editing sounds is like editing reality, if you’re in that kind of mood.

Have a look at Figure 23-5 for a moment. You see that there are two graphs — one big, one small 
— and a strange kind of rectangle.

You can zoom in for more detail by making the view rectangle smaller (just drag it from one end). 
You can zoom out — all the way, if you want, so that both graphs actually show the same thing — 
by dragging the view rectangle boundaries outward.

Finally, to retain the same magnification but move elsewhere in the sound, click inside the view 
rectangle and drag to either side.



Saving and moving sounds

HyperCard’s on-line help (choose About Audio from the Edit menu) gives plenty of tips 
on installing your newly recorded (or edited) sound into other HyperCard stacks. It’s 
mum, however, on the topic of installing them elsewhere on your Mac.

The answer lies in ResEdit, included with this book. See Chapter 21 for basic 
instructions. See the “Six great things to do with sounds,” next, for specific instructions 
on grabbing sounds out of HyperCard stacks and pasting them elsewhere.

Sound formats

FSSD sounds

This kind of sound, featuring the little RCA/Victor logo dog, 
isn’t as convenient as a System 7 sound; fortunately, most of 
the new sounds created these days are in System 7 (snd) 
format. You can play an FSSD file using SoundMaster 
(shareware), Sound Edit (the program that comes with Mac 
Recorder — you can use it to convert the sound), or 
SoundMover (shareware). 

SoundMover suitcases

If you have SoundMover, the shareware program, great. If not,
you can use ResEdit, included with this book, to open this 
suitcase.

After it’s open, highlight the name of a sound in the list. From 
the Edit menu and choose Copy. Paste it into the Scrapbook or 
the Sound control panel, and it behaves just like any other 
System 7 sound.

sidebar: Macintosh Secret

Save $300 the easy way

No non-Apple microphone works on the Mac unless you install its driver: a 
small piece of software that goes into your System Folder (and into the 
Extensions folder on System 7). This driver comes with the device — or at 
least it does lately. 

If you bought your Mac Recorder before, say, 1990, it didn’t come with the 
driver. However, it’s easy to get: the Mac Recorder driver is available from 
America Online and other on-line services. (You don’t have to spring the $300 
for the Sound Edit Pro software, which is what you are told if you call up the 
company.)

It may be called Mac Recorder Pro driver or Macromedia Sound System 



driver or somesuch, but you know what it is.

end sidebar 



O t h e r  m u l t i m e d i a  S e c r e t s  
PowerBooks and MIDI
The PowerBook drove MIDI musicians absolutely crazy 
when it first appeared on the market. MIDI, it was said, no 
longer worked.

Actually, MIDI always did work if all you were doing was 
ordinary sequencing of the sort we’re discussing. Only for 
specialized major data transfers — system exclusive data, 
as it’s called — did the PowerBook 140 and 170 bog down 
and stop working with MIDI.

What few realized is that most of the “PowerBooks don’t 
work with MIDI!” cries arose for a completely different 
reason. It turns out that these Macs (even the new models) 
don’t work with MIDI if AppleTalk is off! Open your 
Chooser and make AppleTalk active; then restart. Only then
does a PowerBook correctly handle MIDI information 
through its modem port.

We’re told that the PowerBook Duos and recent full-sized 
PowerBooks have no problem with MIDI. Any PowerBook, 
even one that’s having trouble, can be made to work with 
the addition of an extension called OMS (from Opcode 
Systems, 415-369-8131).

Finale 2.6.3 hidden movie
Finale, the music-notation program, has one of the best 
About boxes ever (version 2, not version 3). Choose About 
Finale from the Apple menu. The Finale logo — a conductor
in the spotlight — appears. Don’t do anything. After ten 
seconds, the conductor gets tired of standing there 
motionless. He drops his arm to his side and walks off the 
podium!

Chapter 24 (Fonts)
Font Troubleshooting
The classic “damaged” suitcase problem



One of the worst aspects of the System 7 font-suitcase scheme is the way your font 
suitcases suddenly become “damaged.” Actually, the Mac just says that the font suitcase
is damaged when you double-click the font suitcase’s icon. In fact, almost always, the 
fonts inside are perfectly okay.

First, try dragging the suitcase file onto the System folder icon. The Mac may install 
them correctly, despite the fact that you can’t open the suitcase on its own. You can 
often have just as much success using Font/DA Mover 4.1 (see Chapter 5) if you copy 
the contents of the troublesome suitcase file into a good suitcase file.



Apple has identified a list of about 12 different circumstances that can lead to a 
damaged System 7 suitcase file. Prominent among them: putting more than eight styles 
of the same font into a suitcase.

The damaged-suitcase syndrome can also occur if 31 characters of two fonts’ names, in 
the same suitcase, are the same. The problem is that, theoretically, a font’s name within
a System 6 suitcase can actually be longer than 31 letters. But a file’s name in the 
Finder can’t. 

When you double-click a suitcase file, you’re actually asking the Finder to open it up 
and turn it into a window, complete with icons and files (the individual fonts inside). 
Since no two files in a Finder window are allowed to have the same name, the Finder 
simply doesn’t open the suitcase at all.

ATM’s time lag

ATM imposes a slight penalty on almost any Mac when you use fonts for which it needs 
to perform its on-screen-smoothing trick. For example, you’ll see the lag when you 
display that type for the first time, zoom in or out, or change views in a word processor.

When ATM draws type on the screen, it stores the characters in a chunk of memory it’s 
set aside called the Font Cache. If that memory becomes full, ATM has to dump 
whichever characters aren’t on the screen at that moment in order to display the ones 
that are. Then, when you change views or scroll to a new page of your document, ATM 
sits there and rebuilds the fonts it just dumped from memory. This cycle of purging and 
rebuilding characters from ATM’s memory is what slows you down.

The solution is to increase ATM’s font cache, using its control panel. If the font cache is 
large enough (we know people with 512K ATM caches), you shouldn’t notice much 
slowdown at all, except for the first time you put a new size or font up on the screen.

When ATM stops working

Sometimes ATM simply seems to give up the ghost. You may see incredibly strange 
fonts on the screen for a moment, and after that nothing but chunky, jagged text, as 
though you didn’t have ATM installed at all.

Once again, memory is the culprit. Once again, the solution is to increase ATM’s 
memory allotment (use the ATM control panel).

Unfortunately, we’ve also heard much more disturbing rumors: that Microsoft has 
refused to adopt QuickDraw GX. Instead, Microsoft intends to develop still another new 
type format of its own, which it could then use on both Mac and Windows products. 
Microsoft has invited Apple to adopt this new Microsoft font format — but the 
subsequent ugliness, with what would then be six competing font formats, is too 
frightening to contemplate.



The scrambled System 7 keyset

To the consternation of font nuts everywhere, Apple decided to scramble the locations 
of several dozen of these hidden Option-key characters in System 7. As a result, certain 
keystrokes don’t work anymore to produce the symbols they did in System 6.

If you open your Keyboard control panel in System 7, you see something odd: you have 
two keyboard layouts! (See Figure 24-34.)

Finally, you know why there are two layouts. The only difference between them is the 
scrambling of these lesser-known characters. For example, Â is Option-Shift–R in 
System 6, but Option-Shift–M in System 7. If some symbol isn’t where it used to be, try 
the other keyboard layout and see if it surfaces.

In fact, we considered devoting a 30-page section to illustrating the appropriate 
keystroke to produce every one of these hidden symbols in every font — but it dawned 
on us that you, as the owner of this book, will never again need to know which 
keystroke produces which symbol. You have PopChar, a shareware program. It pops up 
a palette (see Figure 24-33), from which you can choose any symbol in the font for 
instant insertion into your document.

(We illustrated a few of the best Option-key strokes in Chapter 9.)

Avoiding the All-Bold-Italic syndrome

Up until System 7.1, PostScript fonts in bold and italic worked as you’d expect. If you 
put Bookman type on the screen and used the Italic command, the Mac automatically 
displayed I Bookman Italic in its place. (See “Style variations for PostScript fonts,” 
above.)

However, System 7.1 and later can zap you with an oddball style conflict if the screen 
fonts for each style are loose in the Fonts folder (instead of being 



in a suitcase file). The symptom: bold Bookman, italic Bookman, and bold italic 
Bookman all appear on the screen in the bold italic face!

The solution, obviously, is to stuff all of these screen fonts into a single suitcase file.

ATM is out of memory

Adobe Type Manager is one memory-guzzling hound dog. If it’s struggling to deal with 
too many fonts at once, or if its memory allotment is too low, it’ll simply give up and 
stop working, without notice. Jagged text is the result.

You give ATM more memory by opening its control panel. Use the arrow buttons to 
increase the memory and then restart the Mac. A word of caution: When you upgrade to
System 7.1 from an earlier version of System 7, the Mac doesn’t always correctly 
transfer to the new Fonts folder whichever fonts you previously installed. Specifically, it 
does copy the fonts to the Fonts folder. But it sometimes fails to remove them from the 
System file, where they were stored.

After installation, it’s a good idea to double-click your System file and make sure no 
fonts were left behind there. Simply drag their icons into the new Fonts folder (if they 
weren’t copied there) or to the Trash (if they were).

Chapter 25 (Printing)
Printers with hard drives: Are they worth it?

If you’ve got a large font library or need to use lots of fonts in 
a single document, having a printer with a hard drive may be 
an easy way to increase printing speed. Rather than storing a 
font in RAM, the printer reads it off the disk. (You copy the 
printer fonts, not the screen fonts, onto this specially 
formatted hard drive.) The delay that’s usually introduced by 
the Mac downloading the necessary font files from your Mac 
to the printer is eliminated.

Of course, only certain printer models accept a SCSI drive. 
Furthermore, only certain hard drives can be formatted, using 
the LaserWriter Utility, as a “Printer’s Disk.” (Ask before you 
buy!) 

Here’s yet another wrinkle: If you use Adobe Type Manager to 
clear up the jaggies on your screen (or even if you use 
TrueType fonts), you still have to keep a duplicate copy of each
printer font on your Mac. That’s because ATM (or System 7, 
with TrueType fonts) needs to have access to the printer font 
to provide clear screen display. Keeping the fonts on a hard 
drive attached to the printer does save you time, but 
unfortunately, it doesn’t save you Mac disk space.



P r i n t i n g  S e c r e t s  

PowerBook delayed-printing Secret
Some PowerBooks, such as the 500 series, can do the time-
consuming dirty work of printing (processing the document
and converting it into instructions for the printer), even 
when it’s not convenient to print. (We’d say that typing at 
39,000 feet is one example of an inconvenient time.) That 
is, if you try to print when no laser printer is attached, 
you’re offered a Print Later button. When you finally arrive 
at an available printer, all those stored printouts are 
automatically dumped onto paper. 

If you own any other Mac model, however, or if you 
generally print to a non-laser printer, here’s how you can 
use PrintMonitor to accomplish the same thing.

Make an alias of your Print Monitor icon (which lives in the 
Extensions folder of your System folder). Put the alias 
somewhere handy: on the desktop or in your Apple menu. 
(System 6: Just put PrintMonitor itself on the desktop.)

When you’re on the plane and ready to print, launch Print 
Monitor, and choose Stop Printing from the File menu. 
Nonsensical though it may seem, now start printing your 
documents! Obviously, nothing actually prints, but Print 
Monitor preserves the printouts in disk form, in your 
PrintMonitor Documents folder.

When you finally are hooked up to a printer, launch 
PrintMonitor again. From the File menu, choose Resume 
Printing. Your suspended printouts will start spewing forth. 
(They’ll also start printing automatically the next time you 
turn on the PowerBook.)

You can use this same technique on non-PowerBooks, of 
course — to prepare printouts while your printer is busy or 
turned off, for example. And you can use QuickDraw GX’s 
Printing menu (the Stop Print Queue command) to 
accomplish the same thing.

LaserWriter Pro upgrades



Adding memory to the LaserWriter Pro is a tad 
complicated. These printers contain one double-sized, 80 
ns, 72-pin, 8MB RAM chip. 

Unfortunately, these printers have a little quirk. The 
LaserWriter Pro has two memory banks. But if there’s a 
double-sided SIMM in one slot, as there is when you first 
buy the printer, each side of the chip is recognized as an 
individual bank. Therefore, you can’t add another 8MB 
SIMM to the second bank to get a total of 16MB RAM — a 
rude surprise for a number of people we know.



The only way to get more memory in the LaserWriter Pro is 
to remove the existing 8MB SIMM from the first slot and 
replace it with a 16MB SIMM. To reach the maximum 
32MB capacity of the Pros, you have to add two 16MB 
SIMMs (which is apt to leave a growing market of partly 
used 8MB chips out there).

Installing the Level 2 driver
Whether your copy of the Level 2 driver came from Adobe 
or Apple, you install it using the standard Apple Installer. 
The Adobe driver comes with over 200 PPDs, however. Our 
advice: Click Customize at the main Installer screen and 
install only the set of PPDs that includes your particular 
printer. 

After you install the driver, the next step is to configure it 
to your printer. You customize it by opening the Chooser, 
selecting your printer, and clicking Setup. You get a 
window like the one shown in Figure 25-9.

The driver automatically looks through the installed set of 
PPDs to find one that matches your printer profile. It loads 
the correct file by itself. 

What’s my printer like?
The Level 2 driver gives you all kinds of insider information
about your particular printer. In the Chooser, click the 
driver’s icon. Then click Setup, then More Choices, and 
then Get Info. 

Use the StyleWriter II driver for the StyleWriter I
The StyleWriter II printer comes with its own super-duper 
printer driver. This driver offers several advantages over 
the original StyleWriter driver: faster printing, better 
grays, and so on.

Apple has finally admitted that you can use the StyleWriter 
II software with the original StyleWriter. The only obstacle 
to your using it is getting it. Throw yourself upon the mercy
of a StyleWriter II-owning friend or a friendly dealer. (Or 
get System 7.5, which includes the II driver but not the I 



driver.)

(Ed. note: The same applies in later driver generations--
that is, you can use the StyleWriter 2400 driver for the 
StyleWriter II, and so on.)

Why didn’t Apple originally encourage StyleWriter I owners
to use the new driver? We have our theories. Among the 
most plausible: Remember that jet-clearing trick in the 
previous Secret? Because the StyleWriter I doesn’t use the 
same mechanical components as the II, we’ve heard rumors
that using that print head-cleaning option could actually 
damage your StyleWriter I. Our advice: Get the new driver, 
but just don’t use the “Clean ink cartridge before printing” 
option.



StyleWriter II driver installation hazards
When you prepare a Mac for use with a StyleWriter II, 
you’re supposed to use the original StyleWriter II 
installation disks. But suppose you already own a Mac that 
works with the SW II, and you want to set up a friend’s 
Mac. You might be tempted simply to grab the StyleWriter 
II driver icon from your Extensions folder, stuff it onto a 
floppy disk, and be on your way.

Watch out, though. The SW II driver isn’t the only 
component you need to make a Mac work with this printer; 
you also need a special version of the Chooser! Be sure, 
therefore, that you also copy the Chooser from the first 
Mac’s Apple Menu Items folder; it needs to be installed on 
the new Mac, too.

Of course, using the original StyleWriter install disks — or 
System 7.5 — would obviate the need for this chicanery.

Creating PostScript files in System 6 
On a System 6 Mac, creating a PostScript file is a little 
trickier. (This is really a Macintosh Secret.) First, turn off 
Background Printing (open the Chooser to do so). Then 
choose Print from the File menu and click OK. Just as the 
printing process begins, press ⌘-K. A new file, called 
PostScript0, appears on your hard drive. 

Then again, maybe you should press ⌘-F. The first time you
print something on a PostScript printer, the Mac has to 
initialize the printer by sending it a “prep file” filled with 
useful information (identifying the computer as a Mac, for 
example). Without being initialized, the printer won’t work.

The difference between the ⌘-F and ⌘-K shortcuts for 
System 6 is that the former doesn’t include this prep file as 
part of the resultant PostScript file, and the latter does. A 
PostScript file you create using ⌘-F takes up less space on 
the disk, but it can only be printed after the printer has 
already been initialized (by printing some other file 
normally, for example, also from System 6). A PostScript file
you create with ⌘-K, on the other hand, takes up more disk
space but automatically sends the Laser Prep info to the 



printer, making it a safer bet. (The ⌘-K shortcut includes 
all the fonts into the PostScript file, too, making the file 
especially huge. See “On the Level About Level 2,” in this 
chapter, for the ramifications of embedding the fonts in a 
PostScript file.)

I m a g e W r i t e r  S e c r e t s

test page



The ImageWriter II prints self-test samples of all three 
printing modes. To do this, turn off the printer. Hold down 
the Form Feed button as you turn the printer back on. This 
starts the Draft mode-self test. 

While the test page is printing, push the Line Feed button 
and then push the Print Quality button to select a new 
mode. Reselect the printer by pushing Line Feed again. 
When the print head begins a new line, it prints in 
standard-quality (Faster) mode. Repeat the Line Feed/Print 
Quality/Line Feed sequence to start printing the test page 
in Best mode.

circles print circular
The normal settings for an ImageWriter aren’t so normal, 
actually, because a perfect circle on the screen gets printed
as an oval. That is, the ImageWriter tends to stretch every 
graphic slightly.

To get around this problem, select the Tall Adjusted option 
in your Page Setup box. Tall Adjusted makes the number of 
dots the same both horizontally and vertically. Graphics 
print with their proper shapes — but now text is distorted 
because the width of the page increases by 11 percent. The
only workaround: consider printing the graphics on a 
separate pass through the printer (or on separate pages).

Make Draft mode work for you
Draft mode usually looks horrible because the printer uses 
a built-in font and ignores the font you used on the screen. 
Yet it does pay attention to where each word on the screen 
begins, in terms of its horizontal placement on the page. 
The result: the printed words are incredibly far apart.

There’s a great trick, however, for avoiding this weird word
spacing: format your document on the screen in Monaco 
10-point font. It’s a decent match for the small monospaced
font the ImageWriter uses for Draft printing. For the first 
time, you’ll get reasonable Draft-mode word spacing.

sidebar: Answer Man



A keyboard jack on the LaserWriter?

Q: This must have been a design mistake. There’s a keyboard/mouse jack on 
my Apple LaserWriter! 

A: That ADB port, which comes on the original LaserWriter II series (the SC, 
NT, and NTX) was designed to handle “future expansion,” as the press release
put it. In other words, it was supposed to be able to control external devices 
such as cut-sheet feeders, output collators, and so forth. 



Unfortunately, no such add-ons were ever made available. To further frustrate 
matters, even if the devices did exist for these printers, the printers’ ROM is 
not equipped to read the port. Since these printers are no longer in 
production, this is one feature that will probably never be used.

end sidebar 

Printing Q&A

Question: I sent a six-page file to a LaserWriter. After about a
minute, I noticed the menus took forever to drop down and the
mouse seemed to be ignoring my clicks. Then, all of a sudden, 
things began working again. Then the cycle would repeat. I 
ran Norton Utilities and it said, “PrintMonitor was 
damaged…” so I replaced it. Weird.

Answer: When something goes wrong in the printing process, 
the system software takes a few seconds to digest the 
message. During that time, you may think the system has 
crashed. Then, in a moment, things will start working fine 
again.

As for the PrintMonitor damage: there’s a bug in System 7.0 
and 7.0.1. It sometimes causes PrintMonitor to quit 
unexpectedly or to become corrupted. Fortunately, there’s an 
easy workaround: don’t quit the program you’re printing from 
until the printing is over. 

Fortunately again, there’s a simple longer-term fix: install 
System 7 Tune-up, Version 1.1.1. (Get it from an Apple dealer, 
a friend, or an on-line service.) The PrintMonitor problem was 
fixed in System 7.1.

Question: I’ve noticed a similar problem with all recent Apple
printer drivers: When first printing, I get a dialog box asking if
I want the memory size of PrintMonitor increased. After one 
or two times, everything is okay.

Answer: This is normal. When you first install your System 
software, PrintMonitor comes with a memory allotment of only
80K. Often, that isn’t enough to spool a document efficiently. 
Fortunately, the System software is smart enough to figure out
what’s going on, and it offers to boost PrintMonitor’s memory 



allotment to avoid the problem. (Apple’s Level 2 driver comes 
with a version of PrintMonitor whose memory allotment is 
preset at 130K.) 

It’s easy to give your current PrintMonitor more memory. 
Select its icon (in the Extensions folder under System 7); 
choose Get Info from the File menu; and type a larger number 
into the Current Size or Preferred Size box. That should 
eliminate the “increase the memory size” messages and give 
you faster printing in the bargain.



Question: Whenever I try to print, I get an out-of-memory 
message. I’ve already followed your instructions in the 
previous trick and increased PrintMonitor’s memory 
allotment. I’m using System 7. What am I doing wrong?

Answer: When it’s printing, PrintMonitor steals some memory
from the Finder, so increasing PrintMonitor’s memory may not
be the end of your troubleshooting. 

You can try increasing the application memory of the Finder, 
but that’s not easily done; if you select Get Info after 
highlighting the Finder’s icon, you won’t see any way to 
change its memory allotment. Solution 1: Restart your Mac 
with System 6 (if it works under System 6; the newer Macs 
won’t). Then you’ll be able to change the System 7 Finder’s 
memory just as you can do with any other application. 

Solution 2: Make a copy of the Finder, open up ResEdit, open 
its Size resource, and increase the minimum memory 
allotment. (See Chapter 21 for the full particulars on using 
ResEdit, which is included with this book.) Restart the Mac 
with the edited Finder in place.

Question: I’ve been getting out-of-memory problems with 
PrintMonitor on my IIci, which has 8MB of memory. An Apple 
technician finally solved the problem: it turns out the problem 
was insufficient free space on my hard drive. Why would that 
make a difference?

Answer: When using Background Printing, the printer driver 
stores the printout on disk as a spool file, which PrintMonitor 
eventually gets around to sending to the printer. After it’s 
printed, the Mac automatically deletes the spool file. 

Depending on how big and how complex your document is, 
that spool file can be anywhere from 100K to a few dozen 
megabytes. If you don’t have enough free space on your hard 
drive to accommodate this file, your choice is to free up the 
space or turn off Background Printing.

Question: Why can’t I use Background Printing with my Mac 



LC and StyleWriter in System 7? I could do it when I had 
System 6.0.7 installed.

Answer: You need to upgrade your StyleWriter driver. This 
problem was fixed in the StyleWriter driver version 1.1. This 
new StyleWriter driver came with the System 7 Tune-Up and 
System 7.1 (you can probably get it from an Apple dealer).

Question: I just installed the System 7 Tune-Up extension, 
and now my Microtek PostScript printer doesn’t work. What 
did Apple do to me?

Answer: Ah, you mean the Microtek PostScript-clone printer. 
The Tune-Up kit includes new, more efficient printer drivers 
for PostScript printers. 



Apple tested these new drivers with true Adobe PostScript 
printers but not with all the clones. Go back to the 7.0 printer 
driver, or contact the manufacturer of your printer and see if 
they have a custom driver you can use.

Question: Every time we try to print a document from a 
networked Mac, the printer restarts, or we get messages 
about the printer being initialized.

Answer: It sounds like you’ve got Macs on the network 
running both System 6 and System 7. These two systems have 
conflicting PostScript drivers; each time you switch from one 
to the other, the printer has to be reinitialized.

The solution is simple: install the System 7 LaserWriter driver 
(the icon called LaserWriter, in the Extensions folder) on the 
System 6 Macs. You can even install the Level 2 drivers on any
Mac running 6.0.7 or later.

Send in the clones

When you read the ads for PostScript printers, you sometimes 
see one advertised as being PostScript compatible. That’s not 
the same thing as PostScript!

A PostScript compatible, or clone, is one that some company 
has designed to imitate the way a genuine PostScript 
interpreter (processor) works. Why would anyone bother? 
Because companies who make true PostScript printers have to
pay a licensing fee to Adobe for every single printer they sell. 
A clone, therefore, costs less than a real PostScript printer.

Do not buy a printer that contains a clone interpreter until 
you’ve actually spoken to people who have that model. Find 
out if they’ve had problems. And try the printer out, if you can,
before buying. Clone printers generally work smoothly until 
you try the fancy stuff: complicated FreeHand illustrations, 
say, or, more commonly, Adobe’s Multiple Master Fonts. The 
new Apple laser printer driver may also cause these printers 
to fail (not surprising, really, since the driver was written by 
Adobe!).



Chapter 26 (Scanning)

S c a n n i n g  S e c r e t s
Buying tips
When buying from a store, take along a sample of whatever
kind of document, photograph, or artwork that you’ll be 
scanning in your regular work. Try out the scanner. See 
how well the supplied software enables you to correct or 
manipulate the image. Copy the resulting image onto a disk
so that you can review it on your own Mac to see how easy 
it is to work with in your own software.



Here’s a perfect way to test a scanner’s capabilities: Try 
scanning in a page of agate type — that’s the super-tiny 
type (usually about 5.5 point) used in newspapers for listing
sports statistics and financial data. Grab a page of baseball 
stats, run them through the scanner, and take a look at the 
results. You’ll get a good idea of how clearly the scanner 
can read and reproduce fine print.

Also consider how long the scan takes. A three-pass color 
scanner naturally takes several times longer to process a 
color photograph than the single-pass model. Weigh the 
time it takes to do a scan against the quality of the finished 
result. If you intend to do lots of scanning, you may have to 
weigh the time against image quality if the best results are 
produced by the slowest scanner.

If you need to make any notations on an image to be 
scanned, use a nonrepro-blue pen or pencil. You can buy 
such a pen or pencil inexpensively from an art or office 
supply store. 

These markings are invisible to most scanners. You won’t 
have to do time-consuming editing work later on to clean 
off the garbage from your scanned image.

Before plugging into your scanning software and getting on
with it, first study the image carefully and see what kind of 
image processing it requires. Most scanning software lets 
you make basic adjustments: to contrast between the 
lightest and darkest areas, and brightness. Even if you 
intend to do most of your picture touch-ups in an image-
processing program, it’s still a good idea to get the best 
quality scan first. Fixing a poor-quality image later may not 
always be an easy task. Don’t forget the phrase “garbage 
in, garbage out.”

Chapter 28 (Online Services)

O n l i n e - s e r v i c e  s e c r e t s
As the world turns
When you’re using CompuServe Information Manager 2.0.2



and you choose the About CIS command from the Apple 
menu, you see an animated spinning globe in the About 
window. If you Option-click the globe and keep holding 
down the mouse button, the earth will start spinning in the 
other direction, and additional windows will appear with 
the program’s credits listed.

New-locality shortcut for America Online and eWorld

The software for America Online 
and eWorld software, if you hadn’t
noticed, is practically identical. No
wonder, because Apple (eWorld’s 
creator) licensed the program 
from the America Online people.



Anyway, both programs offer a 
handy feature on the startup 
screen: a Locality popup menu 
that lets you choose from among 
several dialing locations. If you 
often travel between New York 
and L.A., for example, you can 
simply use this popup menu to 
switch from one set dial settings 
(local access phone number, prefix
codes, modem sped, and so on) to 
another with one mouse click.
To add a new city to this popup 
menu, you’re supposed to choose 
Get Local #  from it. Then you 
wait while the program dials an 
800 number, shows you your 
choices, makes you choose one, 
and so on. But suppose you 
already know the number? 
Suppose you don’t want a whole 
new city at all, but simply want to 
choose between the 2400- and 
9600-bps phone numbers for one 



city? 
Here’s how to add or edit the 
Locality menu — without using the
Get Local # function at all.
Return to the Finder. In the 
America Online (or eWorld) folder, 
open the Online Files (or eWorld 
Files) folder. There you find an 
icon for each of your Locality 
settings. Highlight one of them, 
choose Duplicate from the File 
menu, and rename the copy (e.g. 
New York 2400). 
Now double-click the new icon. It 
opens to the usual Locality screen,
where you type in the phone 
number and make your settings. 
Do so and then click Save. Your 
new settings file is now listed in 
the Locality popup menu.
Apple’s secret Performa forum

Buying a Performa doesn’t get you



merely free software and a free 
modem. If your model came with 
America Online software, you also 
get your own secret Q & A forum 
on America Online.
Your version of the America Online
software is called something like 
2.0.1a or 2.1a. Other versions 
don’t permit access to the secret 
area, which is called Club 
Performa. It’s literally the only 
America Online area officially 
staffed by Apple reps. (Club 
Performa is not to be confused 
with the generally available 
Performa Resource Center.) Visit 
your secret Club . . . but don’t tell 
anybody!

Chapter 30 (SCSI)

The search for some sort of standard to regulate 
connecting extra devices to a computer began in
the 1960s. IBM Corporation developed a 
standard called OEM Channel for its mainframe 
computers. OEM Channel was a fairly successful



system of transferring information. Too 
successful, actually, as far as IBM’s competitors 
were concerned; the Federal 



government adopted it as a standard. IBM’s 
competitors went to court in an unsuccessful bid
to prevent the standard from being adopted.

In the early 1980s, Shugart Associates, a disk 
drive manufacturer, and NCR Corporation, who 
makes the SCSI chips found in your Macintosh 
today, teamed up to develop a new standard 
based on IBM’s OEM channel. They called it 
SASI, short for Shugart Associates System 
Interface. (Before the Mac came along, nobody 
ever named anything with words —  only 
acronyms.) SASI became the forerunner of SCSI,
which was adopted by the American National 
Standards Institute (ANSI) in June of 1986.

Chapter 31 (Networks)
How to set up Apple Remote Access
Step 1: Remote Access Setup

On the host Mac, open the Remote Access Setup control panel (see Figure 32-34). From
the Modem pop-up menu, specify what particular brand of modem is attached to your 
machine. 

This is an important step. If your modem brand isn’t listed in the pop-up menu, you 
have to call up the modem manufacturer to see if an ARA script is available for your 
modem. (This kind of script is also posted in the libraries of user groups and on-line 
services like America Online.) Unfortunately, if you can’t locate a script for your 
modem, it won’t work with ARA. 



Once the modem type is selected, select the Answer Calls checkbox if you want this 
Macintosh to accept incoming calls. You can also set up the checkbox on the bottom of 
the control panel’s window, which lets you set up a time limit for incoming ARA 
connections.

The last option, “Allow access to,” lets you confine the caller to perusal of only the host 
Macintosh (instead of the entire network connected to it).

Step 2: Users & Groups



Next, on the Macintosh you’ll be calling, open the Users & Groups control panel. Set it 
up with your name, if you haven’t already, and turn on your remote dial-in features. 
(See Figure 32-35.)

Setting up the PowerBook

Your host Macintosh is ready to accept calls. Now you have to 
set up the PowerBook. 

Install ARA. Set up the PowerBook’s Remote Access Setup 
control panel, just as you did for the host Mac, and specify the 
modem model you’re using. Then launch the Remote Access 
application.

An untitled document window opens (see Figure 32-36). Enter 
your name as you entered it on the host machine. Then type in
the host Mac’s telephone number and enter the password you 
assigned to yourself.

If you want, click the bottom checkbox. ARA reminds you 
every so often that you’re connected to a remote Mac. (If you 



fail to acknowledge the reminder — if you had to run out, for 
example — ARA automatically hangs up to save you the long-
distance charges.) Believe it or not, this is a useful option; 
connecting to a remote Mac by long distance is so effortless 



it’s actually fairly easy to forget you have a live connection to 
Australia (we’ve done just that — no kidding!).

Fortunately, you can save all this information you just entered. 
(Choose Save from the File menu.) Henceforth, this set of 
dialing information (name, password, phone number, and so 
on) is called a connection document. Such a document is 
hugely convenient because you can set one up for each remote
computer you need to call. Thereafter, you don’t need to 
reenter all that information.

How to connect

Once the finished connection document is on-screen, click 
Connect; the computer does the rest! During the time it takes 
to make a connection, you see a status window, as shown in 
Figure 32-37.

   

To hang up, click Disconnect.

N e t w o r k  S e c r e t s

The classic unremovable SyQuest problem
It may not surprise you that you can’t rename or trash a 
folder or disk that you are sharing. 

But you also can’t rename or remove a disk that you aren’t 
sharing! That’s right: if you turn on the file-sharing feature 
using the Sharing Setup control panel, you’re suddenly 
prevented from touching any disk (larger than 2MB — in 
other words, larger than a floppy) on your Mac, even if you 
aren’t explicitly sharing any of them. {Ed. note: This 
problem was solved in subsequent system versions.}

As owners of SyQuest cartridge drives can attest, this 
feature has its irritating aspects. If the icon of a cartridge 



(or a CD ROM disc, for that 



matter) is on the desktop at the moment you turn on file 
sharing, the Mac doesn’t let you eject it! 

The explanation: the Mac is always prepared to offer you, 
the Owner, full access to all mounted disks from any Mac 
on the network. Therefore, it steadfastly hangs onto every 
disk or cartridge in anticipation of the moment when you 
might need to access it from elsewhere on the network. 

You have to open the Sharing Setup control panel, turn off 
Sharing, eject the cartridge or disk, and then turn Sharing 
back on. (Or just get UnmountIt, part of the freeware 
package File Sharing Improvement Doohickeys, which does
all that automatically.)

begin sidebar: Macintosh Secret

Apple knows a better idea when it sees one

If PhoneNet connectors are so superior to Apple's own LocalTalk wiring system,
don't you wonder what they use at Apple Computer?

When we had occasion to visit Apple's offices in California, we were more than
a little surprised to see @md guess what? @md PhoneNet connectors 
attached to Macs all over the building.

Of course, most of the LocalTalk wiring has been upgraded to Ethernet 
networks, but the little gray Farallon boxes can still be found hiding under 
many a desk. Only in May 1993 did Apple Computer finally acknowledge that 
the emperor had no clothes @md and begin to sell PhoneNet connectors on its
own.

end sidebar

Chapter 31 (Slots)

S l o t  S e c r e t s  
NuBus and Power Macs
If you own a Power Macintosh, or are thinking of buying 
one, be aware that not every NuBus card is compatible with
the PowerPC-based Macs. Video-card incompatibilities, 
apparently, are causing the biggest problems. If you’re 



shopping for a  video card, or are planning to install a card 
from your old Mac into a Power Mac, check with the 
manufacturer of the video card to make sure the card will 
work in the newer machines.



What’s up for NuBus90
First, there’s speed. A feature called the IIx Block Transfer 
Protocol will double the speed of information flowing 
between the Mac and the card (to 20MHz from the current 
10MHz). 

Another feature of the NuBus90 spec is something referred
to as a 5-volt trickle charge. This lets a NuBus90-capable 
board receive current when your Mac is turned off but still 
plugged into the wall socket. How this trickle charge 
feature will affect your Mac is only a matter of speculation, 
but here’s one possibility. Imagine a NuBus90 fax/modem 
board. The trickle current lets it remain in standby mode. 
Then somebody sends you a fax. The modem receives the 
telephone signal, turns on your Macintosh, and receives the
fax. When the fax is finished, your Mac shuts down again. 
When you sit down at your Macintosh later, you receive a 
message that a fax came in. 

IIsi NuBus card into a PDS
The Macintosh IIsi has a special dual-purpose slot. 
Technically, it’s a PDS. But if you buy a $200 adapter card 
from Apple, you can install a NuBus card into it instead.

Some PDS boards are equipped with adapters that allow 
you to install a second card. But you may not want to 
attempt this piggybacked scheme in the IIsi. Unlike other 
Macs, this model’s smallish power supply doesn’t have 
enough juice for that sort of expansion.

Mac II NuBus glitch
If you’ve got a very early Mac II, you may have a problem 
with any NuBus board that has more than 1MB of memory 
built onto it (which probably includes many video display 
boards). If a NuBus board on a Mac II is giving you trouble 
that you can’t solve, have your dealer run a little 
application called NuBus Tester on it (they can get it from 
AppleLink or from Apple). If your Mac II’s motherboard 
fails the test, you’re supposed to be eligible for an upgrade.

NuBus troubleshooting



Some NuBus cards are extremely slot-sensitive. That is, 
they may work perfectly in one of your Mac’s NuBus slots 
and not work at all in another. (Evidently, some companies 
manufacture the circuitry in their cards to narrower 
tolerances than Apple does.) 

Here’s the point: If you install a card and it doesn’t work, 
try installing it in another one of your available NuBus 
slots. If that doesn’t work, try switching it with the cards 
installed in other slots. You may have to shuffle the cards a 
bit before arriving at a card and slot configuration that 
makes all the cards happy.



Chapter 33 (Troubleshooting)
Hunting down an extension conflict

Each extension is a miniprogram. Each, therefore, loads into 
your Mac’s memory when you start up for the day. Sooner or 
later, a couple of these extensions will probably fight for the 
same piece of memory. The result, as Mac veterans well know, 
is either erratic Mac behavior or a system crash.

If you’re the unlucky victim of an extension conflict, as such a 
mishap is known, there are a couple of things you can do 
about it. The first thing you should try is holding down the 
Shift key as the Mac starts up, thus turning off all nonessential
extensions or control panels. You wind up with a Mac that’s 
running a bare-bones System folder, exactly the way Apple 
intended. (Technically, you don’t have to press the Shift key 
until you see the smiling Mac icon, and you can release it 
when you see the “Welcome to Macintosh” screen with the 
words “Extensions off.”)

The Shift-key trick is well and good, but it leaves you with 
virtually no extensions running. At that point, you’re no closer 
to figuring out which two extensions are conflicting. To solve 
that question, you must embark on an ordeal of trial-and-error 
well known to Mac veterans. First, turn off half your 
extensions and control panels. Then restart and see if the 
conflict is solved. If it is, then add a few more extensions and 
control panels back to the System folder and repeat the 
procedure. If it isn’t solved, you’ve come halfway closer to 
isolating the two extensions that are quarreling. 

This process of conflict-hunting can be made far easier if you 
own a little piece of software called an extension manager. As 
a matter of fact, you do have such a program; it’s on one of the
disks that come with this book. It’s called Extensions Manager,
and it lets you easily choose, at startup time, which extensions 
and control panels you want to load. The ones you choose to 
omit are put into a new folder called Extensions (Disabled). 
Even though this folder is within the System folder, it hides 
extensions from the Mac, which only looks in the three 
locations mentioned previously for extensions and control 



panels to run. (See Chapter 33 for a description of Extensions 
Manager and instructions.)

Another good idea is Conflict Catcher, for which we’ve 
provided a discount coupon in the back of the book. This 
extension manager automates the trial-and-error process of 
tracking down which of your extensions is causing your 
problems.


